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Creating an object (shape)
1 Click on a desired shape from the Palette Window.
2 Click on the work space or drag an area on the work space

Changlng objects' properties

A quick and easy way of changing an object's properties is to click on the object with the RIGHT
BUTTON.
Another way is as follows:

1 Select an object by clicking on the object
2 Click on a menu that contains a desired property option, then select the option.
3 Click on OK button to accept changes.

Changlng global properties

A Quick and easy way of changing global properties is to click on the work
space (not on any object) with the RIGHT BUTTON.
Another way is as follows:

1 Make sure no object is selected (highlighted), to do this by clicking on
the work space area, not on any object.

2 Click on a menu that contains property options, then select a desired option.
e.g. Style menu for pen attribute, multi-cell grid or font attributes

3 Click on OK button to accept changes
e Any objects created from now on will inherit the current properties

Moving/Resizing objects
e Please see Object Information

Delete objects
1 Select object(s) for deletion

2 Press the DEL key or select Delete option from the Edit menu

Creating new page/Advancing to next page

Click this button on the Iconbar to advance to next page.
If there is no next page, a new page is created.

Embedding a text-object into an non-text object
1 Select a non-text object for embedding text-object
2 Click on the TEXT button from the Shapes window

3 Click on the non-text object.
If the non-text object already had an embeded text-object, then the text in
that embedded text-oobject will be defaulted for editing.

e To automatically attach text-object to a non-text object everytime the non-text object is created,
click on the Default menu, select Attach Text Object.

Saving objects
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Click on the FILE menu
Select SAVE option
Enter a filename

Click OK

Print filename and page number on document

1

2
3
4

Click on OPTION menu
Select PRINT OPTION
Choose desired options
Click OK



Object Information

-

Foreground

Select an Object

e Click on an object with left button

Select more than one object

e Can be done in either of 2 ways

1 Hold down the CTRL key then click on an object with left button.
2 Click and drag an area that covers desired objects

Resize an object

1 Drag (with left button down) on one of the corners of the highlighted frame
(see the figure above). The object size will change according to the mouse
movement.

2 Release the mouse button when the object is sized to desized size.
Move an object

1 Move the mouse arrow on an object

2 Press the LEFT button and hold it

3 Move the mouse. The overall frame of the object will be dragged along.
4 Release the LEFT button

Select a Shape

This window is initially displayed on the right side of the screen
Click on a desired shape for selection

Click on the button on the Iconbar to open the Shapes window if it hasn't
been displayed.

Alternatively, click on the Default menu then select Shapes window option.

This is not a shape. It is a mode that allows user to manipulate objects,
such as, resizing, moving, changing attributes (colors, patterns...)



This object allows users to design own line-shape

This object allows users to design own curve-shape

Select a Symbol

This is the Symbols window. It is not displayed initially.
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Click on the button on the Iconbar to open the Symbols window if it hasn't

been displayed.
Alternatively, click on the Default menu then select Symbols window option.

Draw a shape
¢ Make sure a shape is selected (see above)
e Drag an area on the work space (document window) by holding the left button down then move

the mouse.
Link one object to another object
¢ Aline-object CANNOT be attached to another line-object
e Similary, a shape-object CANNOT be attached to another shape-object



Icon Bar Information

The lconBar is located below the menu

Bold font

[~

Italic font - Affect globally if no object is selected (highlighted)

Underline font - Affect globally if no object is selected
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Rotate selected objects n degree entered on the left of this button
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Attach line object to non-line object
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Detach all links associated with selected objects
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Bring object to front
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Bring object to back

how previous page if any

how next page or create new page

B LB LB

Hide or show the Shapes window containing objects
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Rotating mode
To rotate an object in arbitrary angle, press and hold the left mouse button
on an object then move the mouse up to rotate up, move the mouse down
to rotate down.
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If this button is down, object selection is automatically switched back
to the non-object selection after the object has been drawed.



Hide or show the Symbols window which contains a set of system symbols.
These symbols doesn't have flexible capabilities as the Shapes objects,
i.e. no 3D look, no shadow look, no background.



Object vs Attributes

e This help will explain what attributes(colors,style) affect what objects

Pen Style
e Pen Style and Pen Size affect all objects

e Pen Arrows affect only line-objects
e Colors apply to all objects

General Property
e 3D Depth and Shadow Depth affect all shape-objects and few line-objects

e Text Alignment applies to only text-object

A

L= n

General Depth applies to these shape-objects (on the left)
The value of the GENERAL DEPTH is in percentage of the overall
area of the object



Pen Style

New attributes will be applied to selected objects if any.
Otherwise, it will be applied to global attribute.

Style and Size

e Affects all objects

Arrows and Arrow Length
e Affects only line-object



General Property
e’

3D Depth: Change the depth of the 3D look
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Shadow Depth: Change the depth of the shadow look
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General Depth: Change the shape itself

Text Alignment: Change the alignment of the text-object.




Line Objects vs Shape Objects
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These are line-objects that can be attached to shape-objects

This is the right-angle line with smart object connection.
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Other shapes(including symbol objects) are shape-objects that can be attached to line-objects

Attach objects

¢ Only line-object can be attached to shape-object, not line-object to line-object, nor shape-object
to shape-object

1 Click on a line-object

2 Hold down the CTRL key then click on a shape-object
Click this button on the ICON BAR
or select Attach Object from the OPTION menu

Detach object

¢ Click on an object (either line-object or shape-object)
Click on this button on the ICON BAR

or select Detach Object from the OPTION menu



Object grouping/ungrouping
Objects can be grouped(glued) together a a single object such that if one of
the objects is repositioned, the rest will also be repositioned respectively.

e Grouping doesn't affect object resizing or object's property. It only affects
movement of objects.

¢ If one of objects to be grouped has been linked with other objects(by a line),
it cann't be used for grouping.

Ungrouping

e To ungroup an entire group, the entire group must be selected.
Otherwise, ungrouping only removes selected object(s) from the group.



Tips On Making Flowcharts

1) Create all shapes first, don't make lines yet
2) Create lines to connect the shapes.

This can be done manually or automatically
with the "automatically connect 2 objects” button.

Working in a crowed area of objects,lines

e Click on the "Disable(glue) selected objects" button on the toolbar to disable
selected object(s) from activating by mouse click.

¢ Click on the "Enable all object(s)" button on the toolbar to enable all objects
so that they can be activated by mouse click.



Smart Form Maker

How to select the Form Maker
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Click on this button on the Shapes window until the word "Form" appears on the window caption.

Click on this button to select the form maker.
Then drag an area on the workspace to create an initial form.

How the Form Maker works
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e The RED line is the TOP CONTROL LINE.
Any vertical lines optionally can be made to snap to the control line.

e The BLUE line is the LEFT CONTROL LINE.
Any horizonal lines optionally can be made to snap to the control line.

¢ Only 2 control lines can be made at a time, one can be TOP or BOTTOM,
The other can be LEFT or RIGHT.

Adding more lines
1 Move mouse pointer over the form. Click with RIGHT BUTTON
2 Select adding vertical or horizontal line

¢ Note: To add lines that will have the same property with a specific line,
click on a desired line that will be duplicated prior adding new lines.

Form Text

Click on this button then click on a cell on the form to enter text.

Form Colors
e Change colors for cells only

Select the POINTER on the Shapes window

Click on a desired cell

Hold down the CTRL key, then click on other cells if necessary
Move mouse pointer over the form. Click with RIGHT BUTTON
Select COLOR

To change text background color, click FOREGROUND.
To change text color, click on TEXT COLOR.

7 Click on OK to accept.
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e Change color for cells without embedded text.
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Select the POINTER on the Shapes window

Click on a cell without embedded text

Move mouse pointer over the form. Click with RIGHT BUTTON
Select COLOR

Click FOREGROUND button to select desired color

Click on OK to accept.



Right angle line with automatic linking

How to connect 2 objects with right-angle line

Click on this button to select the right-angle line

1

Move mouse pointer over an object that will be connected with another object

2 Click on a point on the object as starting point of the right-angle line.
Make sure keep the LEFT BUTTON down.

3 Move mouse with the LEFT BUTTON down over another object.

4 Make sure the mouse pointer is on a desired point of the second object,
then release mouse button.

5 The right-angle line will be contructed accordingly.

Special notes

Objects that are linked by the right-angle line are permanantly linked.
Other words, if one of the objects is deleted or selected to be unlinked,
the right-angle line will be deleted automatically.



Tree with flexible branches

How to select TREE shape

Click on this button on the Shapes window until the word "Flowchart" appears on the window
caption.

Click on this button to select TREE shape.
Then drag an area on the workspace to create initial TREE.

Create more branches
1 Move mouse pointer over the TREE, click with RIGHT BUTTON

2 Select"Add 1 line" or "Add 2 Lines" or "Add 3 Lines"
Move branches around

Click on this pointer button

¢ Move mouse over the TREE to a desired line, then drag the line.



Circular Text

e This object allows text to be wrapped around a circle or an arc or naturally.

How to select Circular Text shape

Click on this button on the Shapes window until the word "Form" or "Flowchart" or "Misc" appears on
the window caption.
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Click on this button to select Circular Text shape.
Then drag an area on the workspace to begin entering text.

Circular Text Styles
e COMPLETE CIRCLE: The string of text will be calculated so that it will be
displayed completely in a circle.
e COMPLETE ARC: The string of text will be calculated so that it will be
displayed completely in an arc (half a circle).
¢ NO COMPLETE CIRCLE/ARC: The string of text will be displayed from the
selected position then continue in a circular fashion until the end of the string.
e START AT 0 DEGREE: The string of text will start on the middle position of
the RIGHT side of the object.
e START AT 90 DEGREE: The string of text will start on the middle position of
the TOP side of the object.
e START AT 180 DEGREE: The string of text will start on the middle position of the LEFT side of
the object.
e START AT 270 DEGREE: The string of text will start on the middle position of the BOTTOM side
of the object.

e CLOCKWISE: Direction in which the string of text will be displayed.



OLE Document linking and embedding

Embed SyTools32 Document in other documents

SyTools32 document can be linked or embedded in other documents provided
that other documents support OLE features

Depending on the user interface that other applications supported, specific instructions on how to
embed or link SyTools32 document into other documents cannot be provided. However, the
general instructions may apply in most cases.

General instructions on how to embed or link SyTools32

1

2
3
4

Run a server application which will be used to embed or link SyTools31 document.
Select INSERT OBJECT from a menu (normally under EDIT or OPTION)
Click on "SyTools32 Flowcharting"

Select "New" if to create SyTools32 from scratch or select "File" if to link SyTools32 document
from a file.

Select "OK"

Embed other documents in SyTools32 document

1
2

Select "INSERT OBJECT" from the EDIT menu.

Select a desired document type from the list box .
Example: Painbrush, MicroSoft Word,..

Select "New" if to create the embedded/linked document from scratch
Select "File" if to create the embedded/linked document from a file.
If the "File" is selected, click on "Browse" to locate the file.

Select "OK" to begin creating embedded/linked document.



Arrange Options

e Align
Aligns selected objects. Alignment options are "align horizontally",
"align vertically", etc...

e Connect
Connects selected objects. Connection options are "connect horizontally",
"connect vertically",etc...

¢ Rotate
Rotates selected objects N degree whose value is shown on the Iconbar.

e Send to Front
If an object is overlapped by other objects, this option will bring the object
to the front.

e Send to Back
if an object is on top of other objects, this option will bring the object to
the back. Other words, the object will be overlapped by other objects if any.

¢ Next/New Page
Displays next page. If there isn't next page, a new page will be created.

e Previous Page
Displays previous page if applicable.

e Flip Horizontal
Flips points on selected objects horizontally. That is, points on the left will
be moved to the right and vice versa.

e Flip Vertical
Flips points on selected objects vertically. That is, points on the top will
be moved to the bottom and vice versa.

e Text Attachment
This will change how an embedded text-object is attached to a non-text object. The change will
affect locally in the object or globally in the enviroment. If an object is selected before choosing
this option, then change will affect only on the object. Otherwise, the change will affect objects
that will be created from now on.

e Text Alignment
This option is to change the way that text (string) in a text-object will be displayed. If there has
been any object selected prior choosing this option, then the change will affect only on the
object. Otherwise, the change will affect objects that will be created from now on.



Polygon Property

e Attributes for objects with multiple lines, sides as shown below
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¢ New attributes will be applied to selected objects if any.
Otherwise, it will be applied to global attribute.

Number of sides/lines
e Update number of sides/lines

Sides/Lines length

e The length is specified in percentage of the whole object in vertical
and horizonal directions.

Round sides

e This is applicable to objects that have sides only, NOT lines.



Default Menu

ToolBar

e |tis also called the IconBar which is located below the Menubar.
The ToolBar is shown if there is a checkmark on the item.

StatusBar

e |tis located at the bottom of the main window.
It is used to show information about current settings
The StatusBar is shown if there is a checkmark on the item.

Shapes Window
e Contains shape objects used for drawing.

The Shapes window is shown if there is a checkmark on the item.
Symbols Window
e Contains symbol objects used for drawing.

The Symbols Window is shown if there is a checkmark on the item.
Background

e This is an attribute option for objects.
If it is checked, then the background of newly created objects will be filled with the background
color.

Foreground

e This is an attribute option for objects.
If it is checked, then the foreground of newly created objects will be filled with the foreground
color.

Background Grid

e [fitis checked, then background grid of the work area will be drawn with
the current setting. Default is checked.

Shadow

e This is an attribute option for objects.
If it is checked, then the style of newly created objects will have the shadow.
The shadow style can be changed in the general property

3D Object

e This is an attribute option for objects.
If it is checked, then the style of newly created objects will have the 3D look.
The 3D style can be changed in the general property

Attach Text-Object
e This is an option of whether or not to attach Text-Object to any newly created object.

Auto-off Drawing

e Option to automatically switch to the non-object drawing mode after the object has been created.
The same command can be accessed on the IlconBar

Tip Arrow
e Put an arrow at the tip of a line

End Arrow
e Put an arrow at the end of a line



Features that you may not know

You can design your own shapes

Below are 2 user design objects that can be used to design own shapes.
Select them from the Shapes window

This object allows user to design own line-objects. That is, the object consists of a series of
connections of points selected by the user.

This object allows users to design own CURVE objects. The curve is shaped by user points.

Smart linking of 2 objects with right-angle line

This tool will allow users to connect 2 objects permanently with right-angle line.

Quick and easy way to change object’s properties
¢ Click on an object with the RIGHT BUTTON, a menu of object's properties
will pop up.

e If not clicking on any object with the RIGHT BUTTON, then a menu of
global properties will pop up.

Scale Objects

¢ Objects in the current document page can be scaled to 50%, 75%, 150%.
Click on the OPTIONS menu then select SCALE.
"Scale 50%" means that the new size of an object will be half of the original.

Automatically attach text to new objects

Select "Attach Text To Object" from the Default Menu.
Make sure the item has a checkmark next to it.

¢ Any new created object will have text attached to it. Other words, the user
will be prompted for text input after the object has been created.

Attach a line-object to another object

You can permanantly attach a line-object to another object. That is, these objects are linked.
Movement of one object will affect position of the other object.

Over 200 additional fixed symbols besides flexible shapes
These symbols are available in the Symbols window.

Click on this button on the IconBar to open up the Symbols window if



the window is not shown.

Click on this button on the IconBar to connect and attach 2 objects by connecting a line between
them. This option only applies to the shape-object or symbol-object.

Group/Ungroup objects
Please see Object Grouping

Print document name and page number
¢ Document name and page number can be printed on the document

1 Click on the OPTION menu
2 Select PRINT OPTION
3 Select desired options then click OK



Properties Dialog Boxes

General Property

General Property
e 3D depth

e Shadow Depth
¢ General Depth
e Text Alignment
Polygon Property

Polygon Property
e No of Sides/Lines

e Side Length(%) - by percentage

¢ Whether or not making round sides
Color Property

e Foreground Color

e Background Color

e Shadow Color

e Pen Color

e Text Color

e Arrow Color

Pen Property

Pen Style
e Style

e Size
e Arrow and Arrow Length




How to...

How to change properties of any object

¢ Click on an object with the RIGHT BUTTON, a menu of properties for that
object will pop up.

How to create more than one(1) page of document

Click on this button on the Iconbar to advance to next page.
If there is no next page, a new page is created.

How to print filename and page number on document

e Click on OPTION menu, select PRINT OPTION

How to know what page current being worked on

e Page number indicator is on the right side of the Status Bar which
is located at the bottom of the main window.

How to turn on the Symbols window

Click this button on the lconbar to open/close the Symbols window.
Alternatively, click on the Default menu then select Symbols window.

What is the Symbols window

e The Symbols window contains additional shapes whose attributes(colors...)
are limited but offer a large number of selections.

How to know what shape/symbol is being selected

e [f the Symbols window and the Shapes window are both being shown on
the screen, then the shape/symbol of the window that is on the top is
active (selected).

How to change text in a Text-Object

Click on this button on the Shapes window.



Then click on the Text-Object to modify text.

How to copy and paste an object

1 Select object(s) to be copied

2 Click on the COPY option from the EDIT menu or
hold down the CTRL key then press the letter C

3 Click on the PASTE option from the EDIT menu or
hold down the CTRL key then press the letter V

How to draw/design own shape

e There are 2 user-design objects, one for line-object, one for curve-object

This object allows users to design own objects.
The object is a series of connections of points selected by the users.

This object allows users to design own objects.
The object is a curve drawn by a set of points.

How to change page size

1 Click on the File menu then select Pint Setup
2 Select desired page size
3 Click OK

How to print document in portrait or landscape

1 Click on the File menu then select Print Setup
2 Select paper orientation
3 Click OK

How to put embedded text not in the center of an object

e There are many ways of placing the embedded text on an object
Basic steps are as follows:

Click on the Arrange menu, then select Text Attachment option.
Click on the Arrange menu, select Text Alignment option.
Create an object.

Note: If an object is selected (highlighted) before doing steps above,
the object will be changed accordingly. Keep in mind that what has been
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changed is just to change the object itself, not global setting.  To change global setting,

sure no object is selected before changing setting.



How to move attached objects as a group whose lines connecting them remain unchanged.

e Drag any line that links 2 objects. This action will move all objects as a group.



Keyboard

Insert Keyboard Shortcuts help text here



OLEDocument linking or embedding



Shapes vs Symbols

Differences

e Shapes objects are flexible and dynamically created.
Most of these objects have all available attributes(colors,3D look, shadow look,...)

e On the other hand, Symbols objects are fixed and have limited attributes.
However, the Symbols objects offers variety of symbols.

Attributes that apply to Symbols Objects
e Pen Color (just this attribute)

How to open/close the Shapes / Symbols windows

Click on the button on the Iconbar to open/close the Shapes window.
Alternatively, click on the Default menu then select Shapes window.

This is the Shapes window

This is a user design object that allows users to design own line-shapes by connecting specified
points.

This is a user design object that allows users to design own Curve-Shapes
whose curves are determined by specified points.

Click on the button on the Iconbar to open/close the Symbols window.
Alternatively, click on the Default menu then select Symbols window.

This is the Symbols window



User Design Shape

e Following is instructions to design own shape

This user-design object is used to draw line-object which consists of
connections of line segments

This user-design object is used to draw a curve-object whose curve is based
on a set of specified points.

Select a user-design object(see above) from the Shapes Window

Click on a desired point on the work area with the LEFT BUTTON

Move the mouse to the next desired point, then Click with the LEFT BUTTON
Repeat the step 3 as many as needed

There are 3 ways to end the drawing

a) Click with the RIGHT BUTTON

e b) Double click with the LEFT BUTTON

e ) Click outside the work area with the LEFT BUTTON

The mouse position of the last click to end drawing will not be counted as a part of points specifed by
the user.
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Drag

DRAG means moving the mouse with the LEFT BUTTON down.
Move the mouse on a target object, press the LEFT BUTTON and
hold it while moving the mouse. Release the mouse button when
done.
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